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1.0 Introduction
1.1 Principle of operation

The use of colour video cameras is well established as a means for surveying 
underground pipes. The cameras are typically mounted on a small powered tractor which 
moves through the pipe with the camera looking forward. In a sewer pipe there is 
practically zero visibility if the pipe is full and so the camera survey would require the 
pipework to be drained for inspection. On the other hand a pipe profiling sonar will only 
work when the transducer head is submerged in the water. Unlike a camera which looks 
forward the sonar looks sideways at right angles to the direction of motion through the 
pipe. The head of the sonar rotates rapidly and displays a cross-section through the pipe. 
The sonar uses colour to display the strength of the acoustic signal being returned from 
the pipe which gives an indication of the type of surface (hard or soft) that the beam has 
swept over. The default "rainbow" colour pattern uses red as an indicator of strong signals
and blue as an indicator of weak signals, with the in-between colours scaled 
proportionately.

As the sonar head only takes one second to rotate through 360 degrees at a range 
setting of 125mm the normal method of surveying would be to move slowly through the 
pipe in the same manner as for a camera survey with the sonar beam prescribing a spiral 
over the inside surface of the pipe. The speed of movement is dictated by the diameter of 
the pipe and size of defect that it is required to detect i.e. How coarse the spacing of the 
spiral is. The size of the illuminated area on the internal surface of the pipe is dictated by 
the transducer beam width which for the 1512 is 1.1 degrees and for the 2512 is 1.8 
degrees between the -3dB points. For a 1.1 degree beam width the diameter of the beam 
at 250mm range is 4.8mm whereas at 3m range the beam diameter is 57.6mm.

1.2 The System Hardware
The complete system comprises of an Underwater Unit, Connecting Cable, Ethernet 
Interface Unit with AC to DC Power Supply or Ethernet Interface Unit or Ethernet 
Interface Board, and a Laptop or Desktop PC running windows. The connecting cable 
provides power and serial communication to control the Underwater Unit.

The Underwater Unit has a rotating transducer head enclosed in a protective plastic shell 
at one end and an end cap with underwater connector at the other. The unit may be either 
skid, float, tractor or ROV mounted to allow it to be moved through the pipe under 
inspection. The transducer head projects a narrow beam of acoustic energy and the 
receiver amplifies the echoes from the walls of the pipe. A total of up to 1000 samples are
taken for each transmit/receive cycle and 400 cycles are implemented for each revolution 
of 360 degrees.

The Ethernet Interface Unit collects raw acoustic data from the Underwater Unit then 
digitizes and processes the signal before sending to the host PC via the Ethernet port. A 
quadrature style cable counter may also be connected to the Ethernet Interface Unit to 
enable cable payout to be displayed. DC power for the Underwater Unit must be floating 
from any other supplies and preferably adjustable between +26VDC and +36VDC for the
1512 system or +14VDC and +24VDC for the 2512 system to allow for the cable 
resistance. The Ethernet Interface Unit can be supplied incorporating an AC to variable 
DC supply. The main Sonar program is supplied on a CD and can be installed on the 
operating PC using the set up procedure.
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1512 Underwater Unit

2512 Underwater Unit

Earlier Board

Revision F

Ethernet Interface Board
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Ethernet Interface Unit with AC to DC Power
Supply

Ethernet Interface Unit
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2.0 Specification
2.1 1512 Underwater Unit

2.1.1 Mechanical & Environmental
(a) Overall Length 346mm
(b) Diameter 70mm
(c) Finish Stainless steel & µPVC
(d) Maximum Operating Depth 500m   
(e) Operating Temperature 0 to +40 °C
(f) Storage Temperature       -20 to +70 °C
(g) Weight in air              3 kg 
(h) Weight in water 1.75 kg

2.1.2 Acoustical
(a) Acoustic Frequency 2MHz
(b) Beam Width 1.1 deg. (+/-3dB)

(Conical beam)
(c) Range Resolution (0.125m range) 0.5mm
(d) Min /Max Range for echo returns 100mm to 6000mm
(e) Transmit Pulse Width 4 to 20µsec
(f) Receiver Bandwidth 500kHz

2.1.3 Interface and Cable
(a)     Number of conductors 1 Twisted pair or

coaxial cable
2 Power Cores

(b) Computer control Baud Rate 9600 baud
(c) Maximum cable attenuation 40dB at 2MHz
(d) Power Requirements 26VDC (+/-1V)

             0.5A continuous
             1A peak floating.

2.2 2512 Underwater Unit

2.2.1 Mechanical & Environmental
(a) Overall Length 178mm
(b) Diameter 50mm
(c) Finish Stainless Steel & Peek
(d) Maximum Operating Depth 100m   
(e) Operating Temperature 0 to +40 °C
(f) Storage Temperature       -20 to +70 °C
(g) Weight in air              0.75kg 
(h) Weight in water 0.4kg

2.2.2 Acoustical
(a) Acoustic Frequency 2MHz
(b) Beam Width 1.8 deg. (+/-3dB)

(Conical beam)
(c) Range Resolution (0.125m range) 0.5mm
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(d) Min /Max Range for echo returns 40mm to 2000mm
(e) Transmit Pulse Width 4 to 20usec
(f) Receiver Bandwidth 500kHz

2.2.3 Interface and Cable
(a)     Number of conductors 1 Twisted pair or

coaxial cable
2 Power Cores

(b) Computer control Baud Rate 9600 baud
(c) Maximum cable attenuation 40dB at 2MHz
(d) Power Requirements 15VDC (+/-1V)

             0.5A continuous
             1A peak floating.

2.3 Ethernet Interface Unit

a) Size:-  Ethernet Interface Board 51 x 118 x 18mm
           Ethernet Interface Unit 165 x 105 x 35mm
           Integrated with AC to DC Supply 180 x 180 x 110mm

b) Weight:- Ethernet Interface Board 43g
   Ethernet Interface Unit 360g
   Integrated with AC to DC Supply 3kg

c) Protocol Ethernet 10/100 Base-T

d) Power Requirements

Ethernet Interface Unit :- 9-36VDC (24VDC nominal)
Typ. 2W (quiescent)

Integrated with AC to DC supply :- 110V / 240V AC 1 Amp
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3.0 System Setup
3.1 Ethernet Interface Unit with AC to DC Power Supply

Ethernet Interface Unit with AC to DC Power Supply

(1) Before powering up the system for the first time, ensure that the appropriate mains 
supply voltage has been selected on the back of the Ethernet Interface Unit. The AC 
supply voltage can be selected for either 110V or 240V on the IEC input connector 
by removing the fuse holder and reinserting it such that the desired voltage points to 
the white line.

IEC Connector on back set up for a voltage input of 220 - 240V AC

Failure to select the correct AC voltage may damage the power supply box
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(2) Make sure the IEC connector switch is in the off position and connect the IEC mains 
lead. The power LED on the front will remain off.

(3) Use the sonar to surface cable to connect the Underwater Unit to the Ethernet 
Interface Unit. The connector on the front also features a quadrature encoder input to
display cable payout in the software.

(4) Connect an Ethernet cable between the Ethernet Interface Unit and a PC.

(5) If using a short cable, turn the power supply knob on the front to point to either 26V 
for a 1512 system or 15V for a 2512 system. To allow for longer cables the voltage 
must be increased depending on the resistance of the power cores.

(6) Press the IEC connector power switch on the back to supply power to the 
Underwater Unit. Upon power on the power LED will illuminate and a noise will be 
heard as the motor rotates the transducer to a reference position.

3.2 Ethernet Interface Unit

(1) Use the sonar to surface cable to connect the Underwater Unit to a power supply. 
The 1512 requires a 26VDC (typ.) supply and the 2512 requires a 15VDC (typ.) 
supply.

(2) Connect a 9VDC – 36VDC (+24VDC typ.) supply to the D-Type connector on the 
front (+24VDC to pin 3 and 0VDC to pin 9). The same power supply used for the 
Underwater Unit may be used.

(3) Join Data+ and Data- from the sonar to surface cable to Data+ pin 5 and Data- pin 4 
on the D-Type connector.

(4) Connect an Ethernet cable between the Ethernet Interface Unit and a PC.

(5) The D-Type connector on the front also features a quadrature encoder input to 
display cable payout in the software.

(6) Power on the system and the power LED will illuminate and a noise will be heard as 
the motor rotates the transducer to a reference position.
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3.3 Ethernet Interface Board (Earlier Revision)

(1) Use the sonar to surface cable to connect the Underwater Unit to a power supply. 
The 1512 requires a 26VDC (typ.) supply and the 2512 requires a 15VDC (typ.) 
supply.

(2) All headers on the board are Molex KK 6410 series headers. Pin 1 is the upper most 
pin when looking down on the header with the friction lock on the left.

KK 6410 Series Molex
Connectors

(3) Connect 9VDC – 36VDC (+24VDC typ.) to PL2 pin 5 and 0VDC to PL2 pin 1. The 
same power supply for the Underwater Unit may be used.

(4) Join Data+ and Data- from the sonar to surface cable to Data+ PL2 pin 2 and Data- 
PL2 pin 4 on the board.

(5) Connect an Ethernet cable between the Ethernet Interface Board and a PC.

(6) The PL4 header can be used as a quadrature encoder input to display cable payout in 
the software.

(7) Power on the system and a noise will be heard as the motor rotates the transducer to 
a reference position.
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3.4 Ethernet Interface Board (Revision F)

(1) Use the sonar to surface cable to connect the Underwater Unit to a power supply. 
The 1512 requires a 26VDC (typ.) supply and the 2512 requires a 15VDC (typ.) 
supply.

(2) All headers on the board are Molex KK 6410 series headers. Pin 1 is the upper most 
pin when looking down on the header with the friction lock on the left.

KK 6410 Series Molex
Connectors

(3) Connect 9VDC – 36VDC (+24VDC typ.) to PL5 pin 5 and 0VDC to PL5 pin 1. The 
same power supply for the Underwater Unit may be used.

(4) Join Data+ and Data- from the sonar to surface cable to Data+ PL5 pin 2 and Data- 
PL5 pin 4 on the board.

(5) Connect an Ethernet cable between the Ethernet Interface Board and a PC.

(6) The PL3 header can be used as a quadrature encoder input to display cable payout in 
the software.

(7) Power on the system and a noise will be heard as the motor rotates the transducer to 
a reference position.

Page 12 of 50 

Ethernet Interface Board Top Side



3.5 Pipe Profiler E Software

(1) Install the Pipe Profiler E software on the PC using the supplied CD.

(2) Load up the pipe profiler software on the PC. Wait for a sub window to appear with 
the Ethernet Interface Unit's serial number in the bottom left of the task bar and a 
message confirming the Underwater Unit is connected next to it.

If the sub window does not appear and the Ethernet connector LEDs are 
both flashing on the Ethernet Interface Unit, check the network 
connection.

(3) Click on the control panel icon in the sidebar and in the new window select the status
tab. Readjust the power supply to the Underwater Unit to set the supply voltage 
reading in the software to +26VDC for a 1512 system or +15VDC for a 2512 
system. The system is now ready for use.

Control Panel Icon   Supply Voltage dial for a 1512 system
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4.0 The Pipe Profiler Software

There are two different types of data display windows which are shown as sub-
windows within the main Pipe Profiler software window. The sonar control window and 
the file playback window. Both types of windows share a set of common controls. There 
can be multiple data display sub-windows visible at the same time. One sonar control 
window for each connected pipe profiler sonar and one file playback window if a data 
file has been loaded. If there are no sonar units connected, the software will start without 
any data display windows.

The below image shows a file playback window on the left and a 1512 Pipe 
Profiler control window on the right.

Typically the steps to go through in order to begin collecting data are:

Check that the Underwater Unit is connected. In the bottom left hand side of the task bar 
there are text labels showing the serial number of the Ethernet Interface Unit and the 
connection status of the Underwater Unit. The image below shows that a 1512 
Underwater Unit is connected.
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Also, the Go button in the toolbar on the left hand side will be green if the Underwater 
Unit is connected and ready to start.

Open the System Control Panel to check that the initial settings are appropriate for the 
environment that you wish to scan. Open the System Control Panel by clicking on the 
below icon which can be found in the toolbar.

Click the Record button and choose a directory to store the saved files. The Record 
button can also be found in the toolbar.

Check that the saving mechanism is correct for the specific application. The options can 
be found in the File menu under Save On.

If there is no connected cable counter, then you will want to save every sweep. 

Finally click the green Go button to begin scanning and saving files.
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4.1 Menu Bar

The menu bar contents change depending on what type of sub window (or none) 
is currently selected.

4.1.1 File Menu

Open

Choose a file to load. The file is displayed in the playback window. The playback window 
loads the details of every pipe profiler file (of the same type) contained in the same directory as the 
chosen file. The data can then be played back in sequence. 

Save As (sonar control window only)

Save the current file to a chosen location.

AutoSave (sonar control window only)

Selecting the AutoSave menu item toggles the auto save function on/off. The AutoSave 
menu item is checked when turned on. Choose Directory opens a  Browse For Folder dialog box 
which is used to select the location for files to be saved.

Save On (sonar control window only)

Save On contains two different options for the auto save function. Every Sweep saves a file 
each time the sonar data is updated. Cable Movement saves a file only when the cable payout value 
changes. When not using a cable counter, make sure that the Save On menu item is set to save on 
every sweep. 
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Print

Opens a print dialog box to print a report from the active data display.

Print Preview

Shows a preview of a printed report from the active data display.

Page Settings

Allows the paper size, page orientation and margin sizes to be changed for a printed report.

4.1.2 Window Menu

The Window Menu contains standard windows controls for choosing the active sub window 
and arranging them within the main program window.

4.1.3 View Menu

Log

Opens a logging window which records events within the software. This can be used for 
troubleshooting.
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Device Manager

The Device Manager shows information about connected profilers. The Data Capture 
Device refers to the Pipe Profiler Ethernet board and UWU (Underwater Unit) refers to the Pipe 
Profiler Transducer.

Customize

The Customization window shows the current colour selection for different aspects of the 
graticule on the data display. To change a colour, click the edit button and use the pop-up colour 
selection window to choose a new one. 
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Ethernet Settings

The pipe profiler software has auto detection enabled by default. This means that the 
software will periodically send a discovery message to check for any detected Ethernet Interface 
Unit. Disabling the auto detection will mean that the software will automatically sent one discovery 
message when it starts up and then any subsequent discovery messages will have to be manually 
triggered by clicking on the "Send Manual Detect Message" button.

The Static IP section allows the setting and resetting of a static IP address assigned to a 
particular Ethernet Interface Unit. Powering up the Ethernet Interface Unit will take it through a 
series of steps to decide which IP Address to use. First it checks to see if a static IP address has been
assigned. If there is no static IP address it will request an IP address from a local DHCP server. If 
there is no DHCP server on the network or if the Ethernet Interface is directly connected to a PC 
then it will configure a link-local address.

To configure a static IP, first enter the serial number of the Ethernet Interface Unit and the 
static IP address which you wish to configure it with. Then click the "Set Static IP Address" button. 
The software will broadcast a static IP configuration message on the network.

To disable the static IP address, enter the serial number of the Ethernet Interface Unit and 
click on the "Disable Static IP Address" button. The software will broadcast a static IP disable 
message on the network. Depending on how your network is configured, the disable message 
should be more reliable when the Ethernet interface is directly connected.

4.1.4 Template Menu
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Open

Loads a previously saved template file (*.otl).

Save As

Saves the current template to a file.

Capture

Automatically generates a template to fit the current image data.

Edit

Toggles edit mode on/off. When edit mode is on, the template can be modified by holding 
down the left mouse button and “drawing” by moving the mouse.

4.1.5 System Menu

Cable Counter

The cable counter configuration window is used to select a cable counter type and for 
calibration. The default type is None.

To calibrate the cable counter first set the type to OnBoard.
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If the ticks per metre value is already known from a previous calibration then it can be entered and 
set by pressing the “Set Ticks Per Metre” button bypassing the calibration routine. Otherwise press 
the button “Start Paying Out” and pay out the length of cable that you have decided is adequate for 
the calibration. The number in the Final Count box should change as the cable is being payed out.

After the chosen length of cable has been payed out, enter the length into the numerical text box and
press the button “Length Payed Out”. The calculated value for ticks per metre is now shown (Final 
Count – Initial Count). The value for ticks per metre can also be manually edited at this stage.

Press the “Set Ticks Per Metre” button to apply the calibration setting.

The current displayed cable payout range can be set by adjusting the value in the white entry box 
and pressing the “Set New Payout Range” button. This should be set when the ticks per metre value
is adjusted since the adjustment will change the current payout range (if the tick count is not zero).
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4.1.6 Profile Menu

Settings

The Profile Settings window controls the output of live profile line data to a serial port. The 
output format can be selected from a drop down menu (see Appendix A for a description of the 
different output formats). A serial port can be chosen with the Port drop down menu. The enable 
check box toggles the output on/off. When enabled, the profile is output on the serial port each time 
the on screen profile is updated. The Unit ID is a user designated identifier which is included in the 
output message (see Appendix A).
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4.2 Toolbar

Save File

The Save File button saves the current image to a file. A Save As dialog box allows the 
target directory and file name to be chosen.

Print

Prints a report from the current sonar image. 

Copy

The Copy button copies the current contents of the sonar display to the clipboard as an 
image which can then be pasted into other applications. The image is a copy of exactly how the 
sonar display appears at the moment the button was pressed including the active measuring tools, 
template, graticule etc.

Control Panel

The Control Panel button opens up the control panel window to enable the sonar's settings to
be changed.

The control tab is used to access the main parameters of the pipe profiler. Not all features are
available on all Underwater Units so may be greyed out depending on the connected model.

The range corresponds to the radius from the transducer head, therefore a 900mm (36”) 
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diameter pipe would be best displayed on the 500mm (20”) range. The pulse width is the width of 
the signal transmitted by the sonar transducer, measured in microseconds. The pulse width can be 
adjusted in 2µs steps. Typically the pulse width is adjusted according to the range as follows:

4µs 125mm to 500mm
8µs 500mm to 1000mm
12µs 1000mm to 1500mm
16µs 1500mm to 2000mm
20µs 2000mm to 6000mm

The effect of using a large pulse width is increased sensitivity of the system i.e. more signals are 
displayed as red. The width of the displayed image is also affected by the pulse width. A longer 
pulse width will increase the size of the returned echo.

Step Size controls are used to reduce the angular resolution in order to speed up the scan rate. The 
standard step size is 0.9° which gives 400 steps per 360° sweep. The step size can be increased to 
1.8° and 3.6° which work out at 200 and 100 steps per 360° sweep respectively. This function is 
only available on 1512 Underwater Units.

The Tx Power slider controls the transmit power. This enables the power level to be adjusted to the 
scanning environment. Reducing the transmit power when operating in a short range environment 
may improve the image quality. This function is only available on 1512 Underwater Units.

The Range Resolution has 3 settings Low, Medium or High. These 3 settings equate to approximate 
range resolution settings of 200, 400 or 600 respectively. The actual resolution varies depending on 
range and velocity of sound settings.

The sector settings adjust both the size of the scanned sector (coverage) and the centre angle. The 
illustration changes to reflect the current settings. The coverage is represented by diagonal red lines 
and the centre angle is represented by a single green line. These settings only take effect when 
sector mode is enabled (see Toggle Sector Mode).

The Image tab contains controls to adjust the palette and colour scale used to display the 
sonar image. By adjusting the controls it is possible to remove background noise from the display 
and increase the sensitivity of received signals. The colour adjustment combines the features of both
blanking and gain controls.

The acoustic data is collected using an 8-bit analogue to digital converter, which means raw 
signals are in the range 0 to 255. The colour bar to the left of the page shows the current colour 
scale being used, with the colour for full signal (255) at the top, and that for 0 at the bottom.
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The outline blanking and threshold sliders set the starting range for the profile and capture 
template algorithm. The blanking corresponds to a minimum radius from the transducer head and 
the threshold corresponds to the minimum raw signal level that must be exceeded.

The image blanking slider corresponds to a minimum radius from the transducer head before
the acoustic data is displayed.

The Threshold setting defines the raw signal level at which the background colour is 
selected. Any signals at or below the Threshold setting are displayed in the background colour. If 
the Threshold is set to 0, a level of background noise will be visible on the sonar image. By 
increasing this setting, the background noise will disappear from view, effectively providing a 
blanking control.

The "Max" setting defines the raw signal level at which the peak colour is selected. Any 
signals at or above the "Max" setting are displayed in the peak colour. The "Max" setting in effect 
increases the gain or sensitivity of the system. By lowering this setting, it is possible to bring more 
of the lower level signals into view. The "Max" setting should be adjusted so that the strongest 
signals being detected are displayed in the peak colour.

The "Colour step" setting defines the width of the colour bands in the colour scale. A step 
size of 1 gives a smooth transition between colours. A step size of  16 (maximum) gives an abrupt 
change of colours.

The "Palette" defines the actual colours used to display the image. The palette is chosen 
from a list. There are several internal palettes as well as palettes loaded from file. The file based 
palettes are described by their file name.

The status page shows a graphical representation of the readings provided on the status line 
of the main display window. i.e. pitch, roll and cable payout.

The pitch is displayed in degrees, with positive pitch indicating the sonar is pointing up. The
roll is displayed in degrees, with positive roll indicating the sonar is tilted over to the right 
(clockwise).

The Auto Roll Correction box orients the acoustic image such that data at the top of the 
screen corresponds to upwards facing (perpendicular to the Earth's surface). The Roll Adjustment 
parameter rotates the acoustic image data by the specified amount and is typically used to correct 
for mounting inaccuracies.
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The supply voltage is the voltage measured in the sonar unit. The unit will work 
satisfactorily when the needle on the voltage gauge is within the green area. 

Head Alignment flips the sonar image if “Backward” is selected. This is so that if the 
Underwater Unit is mounted with the booted end backwards, the sonar image can still be viewed as 
though the user is looking down the pipe in the direction of travel.

The velocity of sound ( VOS ) in water is nominally 1500m/s (4921ft/s). The true VOS is 
dependant on a number of factors, including the temperature, pressure and salinity of the water. If 
accuracies within 3% of full scale are sufficient, the velocity of sound may be set and left at 
1500m/s. If better accuracy is required the system needs to be calibrated against a known target 
using the cursor measurement tool. If the VOS is increased, the image will stretch. If the VOS is 
decreased, the image will shrink. An easy way to calibrate the system is to use a vertical sided round
bucket of around 12” (300mm) diameter. Put around 6” (150mm) of water from the pipe to be 
surveyed into the bucket then stand the Underwater Unit on end with the grey transducer end in the 
water in the centre of the bucket. Enable the circle overlay and set its diameter to match the actual 
diameter of the bucket ( measure this as accurately as you can using a ruler ). Set the system 
scanning and call up the status tab of the System Control dialogue. Now adjust the velocity of sound
figure whilst positioning the circle over the sonar image until the inside edge of the sonar image is 
co-incident with the circle overlay.

Remember that it is the inside edge of the sonar image that represents the distance to the 
pipe wall. The thickness of the image is dictated by the transmit pulse width.

The titling page allows text to be associated with the sonar display.

The Title text appears on the title bar of the sonar image.

The notes text does not appear on the main display, but is stored when images are saved.

Toggle Scan

Pressing the Go button starts the system scanning process. If the system is already scanning, 
pressing the Stop button will terminate the scanning process. The main display will be 
automatically updated when each scan completes. The time for each scan depends on the range, step
size (only on 1512 Underwater Units) and resolution. A shorter range and a lower resolution results 
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in a faster update rate. 

Record

Opens a Browse For Folder window to select a save folder. Once a save folder has been 
chosen, AutoSave will be enabled. Pressing the record button again will disable AutoSave.

Measurement Tool

The measurement tool can be used to measure features on the sonar display. The button 
toggles the tool on/off. When the button is toggled on, the left and right mouse buttons can be used 
to set the position of the two ends of the measurement tool. Move the mouse cursor to a position on 
the sonar display and left click to set the start position or right click to set the end position of the 
tool.

Circle Tool

The circle tool is used to measure diameters. The toolbar button toggles it on/off. When 
enabled, hold down the right mouse button and move the mouse to the left or right to decrease or 
increase the circle tool diameter. Hold down the left mouse button and move the mouse to adjust the
centre position of the circle tool.
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Toggle Template

Toggles the template tool on/off. The template tool can be used to compare the shape of the 
pipe at different positions within the data set. The image below show the template tool as a green 
circle around the centre of the data. This is the template tool in it's default state.

Capture Template

Automatically generates a template to fit the current image data. The outline blanking setting
from the Image tab of the Control Panel affects the quality of the captured template. Increase the 
value to mask off data close to the sonar head. The image below shows a captured template on the 
same data as in the previous image.

Page 28 of 50 



Modify Template

Toggles edit mode on/off. When edit mode is on, the template can be modified by holding 
down the left mouse button and “drawing” by moving the mouse.

Toggle Graticule

Toggles the range graticule on/off.

Toggle Profile

Toggles the profile tool on/off. The profile tool automatically takes the shape of the current 
image data and is updated each time the image data is updated. If serial output is enabled (see 
Section 4.1.6) and the profile tool is on, then the profile information will be output to the serial port 
each time it is updated.

Record Profiles

Opens a Browse For Folder window to select a save folder. Once a save folder has been 
chosen the software will begin saving files based on the Save On option found in the File Menu.

Toggle Sector Mode (sonar control window only)

Toggles sector mode on/off. With sector mode off (default) the sonar performs a 360° scan. 
With sector mode on the sonar performs a limited coverage scan based on the sector settings 
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configured in the control panel.

Reset to Defaults

Resets various parameters to the default values. Also resets the measuring tools.

Play (playback window only)

Begins playback through files in the open directory. The order of playback can be chosen by 
right clicking with the mouse on the playback bar at the bottom of the data display.

Some orders may not be suitable for particular data sets. For example, if the data set was 
saved without an attached cable counter then the “Order by Cable Count” option will not play back 
the data set in a meaningful order.
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Pause (playback window only)

Pauses playback.

Fast Forward (playback window only)

Advances through the data set at a faster rate than normal playback.

Rewind (playback window only)

Reverses through the data set at a faster rate than normal playback.
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Appendix A – Serial Output Format
Serial Output Format

There are four types of file outputs that can be selected from the drop down menu as listed below. 

Serial link:- 115200 Baud, no parity, 8 data bits, 1 stop bit, no handshake 

MEPPA:- $MEPPA, UNITCODE, +XXXX, -YYY, +X, +YY.....-….XXX, +YYYY, 
*[CS][CR][LF]

$ Specifies start of a new message.
MEPPA, Marine Electronics Pipe Profiler, message type A.
UNITCODE, 3 “ASCII” characters, unit identifier e.g. A2Z
+X,-YY, +/-x , +/-y co-ords of an "outline" first character '-' or '+'

1-4 characters representing distance (measured in mm from head at 
centre origin 0,0) +X,+Y are xy coordinate pairs repeated as 
necessary

* Terminator – signals end of message.
[CS] 2 hexadecimal ASCII character checksum, being the 8 bit sum 

(modulo 256) of the characters between $ and * inclusive.
[CR][LF] Carriage return, line feed for terminal formatting.

MEPPB:- $MEPPB, UNITCODE, TIMESTAMP, PITCH, ROLL, +XXXX, -YYY, 
+X, +YY.....-XX, +YYYY, *[CS][CR][LF]

$ Specifies start of a new message.
MEPPB, Marine Electronics Pipe Profiler, message type B.
UNITCODE, 3 “ASCII” characters, unit identifier e.g. A2Z
TIMESTAMP, Microsoft time_t format.
PITCH, Up to 4 characters representing a pitch angle in tenths of degrees.
ROLL, Up to 4 characters representing a roll angle in tenths of degrees.
+X,-YY, +/-x, +/-y co-ords of an "outline" first character '-' or '+'. 1-4 

characters representing distance (measured in mm from head at 
centre origin 0,0) +X,+Y are xy coordinate pairs repeated as 
necessary.

* Terminator – signals end of message.
[CS] 2 hexadecimal ASCII character checksum, being the 8 bit sum 

(modulo 256) of the characters between $ and * inclusive.
[CR][LF] Carriage return, line feed for terminal formatting.
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MEPPC:- $MEPPC, UNITCODE, TIMESTAMP, PITCH,ROLL, +XXXX, -YYY, 
INTENSITY, +X, +YY,  INTENSITY, .....-XX, +YYYY, INTENSITY, *[CS][CR][LF]

$ Specifies start of a new message.
MEPPC, Marine Electronics Pipe Profiler, message type C.
UNITCODE, 3 “ASCII” characters, unit identifier e.g. A2Z
TIMESTAMP, Microsoft time_t format.
PITCH, Up to 4 characters representing a pitch angle in tenths of degrees.
ROLL, Up to 4 characters representing a roll angle in tenths of degrees.
+X,-YY, +/-x, +/-y co-ords of an "outline" first character '-' or '+'. 1-4 

characters representing distance (measured in mm from head at 
centre origin 0,0) +X,+Y are xy coordinate pairs repeated as 
necessary.

INTENSITY, Signal intensity at that point ranging from 0 – 255.
* Terminator – signals end of message.
[CS] 2 hexadecimal ASCII character checksum, being the 8 bit sum 

(modulo 256) of the characters between $ and * inclusive.
[CR][LF] Carriage return, line feed for terminal formatting.

MEPPD:- $MEPPD, UNITCODE, TIMESTAMP, CABLE COUNT, PITCH,ROLL, 
+XXXX, -YYY, INTENSITY, +X, +YY,  INTENSITY, .....-XX, +YYYY, INTENSITY, 
*[CS][CR][LF]

$ Specifies start of a new message.
MEPPD, Marine Electronics Pipe Profiler, message type D.
UNITCODE, 3 “ASCII” characters, unit identifier e.g. A2Z
TIMESTAMP, Microsoft time_t format.
CABLE COUNT, Up to 2 decimal places in feet or meters.
PITCH, Up to 4 characters representing a pitch angle in tenths of degrees.
ROLL, Up to 4 characters representing a roll angle in tenths of degrees.
+X,-YY, +/-x, +/-y co-ords of an "outline" first character '-' or '+'. 1-4 

characters representing distance (measured in mm from head at 
centre origin 0,0) +X,+Y are xy coordinate pairs repeated as 
necessary.

INTENSITY, Signal intensity at that point ranging from 0 – 255.
* Terminator – signals end of message.
[CS] 2 hexadecimal ASCII character checksum, being the 8 bit sum 

(modulo 256) of the characters between $ and * inclusive.
[CR][LF] Carriage return, line feed for terminal formatting.
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Appendix B – Sonar Interpretation

The Sonar transducer emits either a 1.1º(1512) or a 1.8°(2512) conical beam of 
sound that covers part of the pipe wall. The greater the distance from the sonar head the 
larger the area of reflection becomes. All echo’s are received, amplified and displayed on 
the screen with the strongest targets in red and weaker one’s in blue.

If the pipe is not full of water then it is possible to have a reflection of the pipe 
above the water line as shown below. The measuring cursor indicates the water line level.
Also the flow is very turbulent with much aeration and debris being displayed in light 
blue colours. The sonar is mounted on a float with outriggers that are displayed in red on 
the image.
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The previous image now has all the clutter removed from the screen by increasing
the threshold control. This has the effect of a gain control and removes the weaker 
targets. The overlay circle shows the pipe diameter and the cursor tool shows the depth 
measurement to the top of the sludge below the sonar head.
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These 2 identical pictures show a fully surcharged Victorian brick sewer in which 
the invert has collapsed and filled with silt. The overlay circle shows where the pipe 
invert should be and the cursor tool the depth of collapse. 

The image below shows a manhole chamber with a lateral entering from the left 
hand side.
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The image below of a fully surcharged brick egg shaped sewer shows a lateral 
entering at the top right hand side. The signal to the left, appearing outside of the pipe, is 
a reflection and should be ignored.
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The image below shows a concrete pipe that has a build up of material on the pipe
walls. It can be seen from the image that the signal strength of the reflected signal (light 
blue) from the material build up is much less than the pipe wall. 
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The image below shows a concrete pipe where the crown has collapsed into the 
invert.
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Appendix C – Connectors

Ethernet Interface Unit with Integrated AC to DC Power Supply

TT Electronics AB Connectors AB052100 1210SN00

Connector Pinout

Pin Function

A NC

B Data-

C Data+

D V-

E V+

F Quadrature Encoder Channel A

G NC

H Quadrature Encoder Channel B

J Quadrature Encoder +5VDC, 200mA output

K Quadrature Encoder 0VDC
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Ethernet Interface Unit

Ethernet Interface Unit Pinout

Pin Function

1 Quadrature Encoder Channel B

2 Quadrature Encoder Channel A

3 +24VDC Power In (9VDC - 36VDC)

4 Data-

5 Data+

6 Quadrature Encoder +5VDC, 200mA output

7 Quadrature Encoder +5VDC, 200mA output

8 Quadrature Encoder 0VDC

9 0VDC Power In
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Ethernet Interface Board (Earlier Revision)

KK 6410 Series Molex
Connectors

Ethernet Board Pinout

Designator Pin Function

PL2 1 +0VDC Power In

2 Data+

3 NC

4 Data-

5 +24VDC (9VDC - 36VDC)

SK2 RJ45 Ethernet Jack

PL4 1 Quadrature Encoder Channel A

2 Quadrature Encoder +5VDC, 200mA output

3 Quadrature Encoder 0VDC

4 Quadrature Encoder Channel B
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Ethernet Interface Board (Revision F)

KK 6410 Series Molex
Connectors

Ethernet Board Pinout

Designator Pin Function

PL5

SONAR

1 +0VDC Power In

2 Data+

3 NC

4 Data-

5 +24VDC (9VDC - 36VDC)

SK1 RJ45 Ethernet Jack

PL3

ENCODER

1 Quadrature Encoder Channel A

2 Quadrature Encoder +5VDC, 200mA output

3 Quadrature Encoder 0VDC

4 Quadrature Encoder Channel B
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Underwater Unit

The connector used to mate to the 1512 Underwater Unit is a Jupiter Type 
FEDF10MT05-16-A-110. For the 2512 Stainless Steel Underwater Unit it is an Amphenol 
Pattern 105 shell size 14-19 socket female however for the 2512 Aluminium Underwater 
Unit the connector is a Macartney MCIL4F. The sonar telemetry should be connected to the 
Ethernet Interface Unit with Data+ to Data+ and Data– to Data–. If a coaxial cable is used 
then Data+ should be connected to the inner and Data– to the outer of the coax. If a shielded
twisted pair cable is used Data+ should be connected to both conductors of the pair in 
parallel and the Data– to the shield/foil/drain wire.

NOTE:- The V+ and V- power connections to the sonar must be fully floating (isolated)
from any other ground connections. No other system connections should be connected 
to the scanner power supply otherwise damage to the scanner can result.

The manufacturers will not be responsible for the cost of any damage resulting from 
incorrect connection of the sonar system.

05-16 5 pin Jupiter layout 
Pin Layout viewed from rear looking at solder buckets

 Pattern 105 19 Pin
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07-20 7 Pin Jupiter layout

11mm Cable Diameter

2x Twisted pair

2 power

MCIL4F 4 Pin
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Pattern 105 Connector Exploded View

Pattern 105 Connector Assembled

To connect the cable, disassemble the connector as shown above. Pass the cable through the 
connector body components and solder the wires to the relevant pins. Once soldered and 
checked for short circuits between pins screw the connector into the body and then assemble
the cable gland remembering to lubricate the o-ring seal and then tighten the back nut to seal
the gland to the cable.

The hole in the body must now be used to back fill the connector with a potting compound 
to ensure a water tight seal.

NOTE: failure to back fill the connector will result in damage to the sonar head due to 
water ingress.

Underwater Unit Connectors

1512 2512

Underwater Unit
Jupiter
5 Pin

Underwater Unit
Pattern 105

19 Pin

Underwater Unit
Pattern 105

19 Pin

Underwater Unit
MCBH4M

4 Pin

Function

1 G B&C 3 V+ 

2 C M 4 Data-

3

4 B L 2 Data+

5 K A&N 1 V- 
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Underwater Unit Connector for Combined Ethernet 1512

Underwater Unit
Jupiter
7 Pin

Function

1 Ethernet Tx+

2 Ethernet Tx-

3 Ethernet Rx+

4 Ethernet Rx-

5 +24V 

6 Not Connected

7 0V

Page 47 of 50 



Appendix D – FAQ

1) Number of Cable Conductors

The 1512 / 2512 Pipe Profiling Sonar's require 4 conductors in the connecting cable from the 
Underwater Unit to the surface. 2 cores are required for power and 2 cores for data communication.

2) Power Conductors

For the DC power conductors the lower the cable resistance the longer the cable run. The 
Underwater Unit draws around 0.5 amps and for the model 1512 the minimum DC voltage at the 
scanner end should be +26VDC whereas the 2512 requires +14VDC. To calculate the required 
voltage measure the DC resistance of the 2 power cores and then use Ohm's Law for the voltage 
drop. ( V=IR where V=Voltage Drop, I=Current, R=DC Resistance ).  i.e. If the cable is 5 ohms per 
conductor then the voltage drop V = 0.5 x 10 = 5V. Thus to achieve +26VDC at the scanner will 
require +31VDC 

3) Data Conductors

The data conductors should be either a coaxial cable or fully screened twisted pair. As the data 
signal is the amplified 2MHz receive envelope the length of cable will be limited by the bandwidth. 
For up to 500m cable length a coaxial cable type RG59 or equivalent is suitable but for lengths up 
to 1000m type RG213 is recommended

4) Data Format

The analogue sonar data uplink characteristics are a nominal level of 0VDC with negative going 
sync pulses (one for each ping i.e. 400 per revolution with a pulse width equal to the transmit pulse 
length setting i.e. 2µsec to 20µsec) then the sonar echo return is a positive going envelope of the 
2MHz acoustic signal. The unloaded voltage for the sonar signal is up to +/- 10VDC but once 
terminated will reduce to around +/- 4VDC.

The digital communications that controls the sonar head plus transmission of the pitch and roll data 
is an RS232 9600 baud signal utilising the same link as the sonar data.
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The previous picture of the 1512 /2512 data comms shows a negative sync pulse followed by 2MHz
receiver envelope.

The above picture of the 1512 / 2512 data comms shows 1 of the 400 steps per revolution of the 
transducer.

The above picture of the 1512 / 2512 data comms shows 5 of the 400 steps per revolution of the 
transducer.

5) Network Connection Issues

The Ethernet Interface configures its IP address in the following order:

1. If there is a static IP address configured then it will use it. (see section 4.1.3 for static IP 
address configuration)

2. If there is no static IP address then a request for an IP  address will be sent to a local DHCP 
server.

3. If there is no local DHCP server then a link-local address will be configured.

Note : Be aware that Windows 7 or newer has a long wait period before messages from a link-local 
address get through to the Pipe Profiler software. This wait period appears to be in the region of 80 
seconds. Therefore you may have to wait up to 80 seconds from when the Ethernet Interface is 
connected before the device will show up in the Pipe Profiler software. Configuring a static IP or 
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having a local DHCP will prevent this.
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